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1. OVERVIEW OF APPLICATIONS

Part A
Software and Workflows
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• These workflows are primarily designed for peptide mapping analyses of 

enzymatically digested biotherapeutic molecules:

‒ Sequence coverage and confirmation

‒ Glycopeptide analysis

‒ Post-translational modification (PTM) analysis

‒ Target PTM profiling

• Batch analysis of replicate samples of the same molecule is possible:

‒ In-depth characterization

‒ Comparison of multiple samples: Process development, instrument method development

‒ Stress tests

‒ Reduced vs. non-reduced sample comparisons

Overview of Applications for Peptide Mapping Workflows

‒ Disulfide-bond (DSB) analysis 

‒ Conjugate analysis

‒ Sequence variant analysis (SVA) 
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2. USING BIOLOGICS EXPLORER

Part A
Software and Workflows
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Using Biologics Explorer

ACTIVITY NODE ICONS

Run
or Reset.

Pause: Pause the workflow here.
All subsequent tasks remain active.

Bypass: Skip this task 
when running the workflow.

Block: Stop the workflow.
This and all subsequent tasks become 
unavailable (gray).

Trash: Do not save intermediate data.
When this icon is activated, the results for this 
particular activity node cannot be viewed.
Using the Trash icon helps to save memory. Use this 
feature after workflow settings have been optimized. 
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Using Biologics Explorer

WORKFLOW ICONS

Workflow Completed
All activity nodes have completed successfully.

Workflow Paused
Some activity nodes have been completed successfully, 
but some have not yet started.

Workflow Ready
No activity nodes have been completed. The 
workflow is ready to start.

Workflow Error
Some activity nodes have been completed successfully, 
but at least one activity node cannot run.

Workflow Warning
Some activity nodes are incomplete.
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Using Biologics Explorer: General Overview

START AND SAVE WORKFLOWS

To open a workflow, do one of the following:

• Copy a workflow from the Templates folder.

1. Right-click on the workflow and then select Copy.

2. Right-click the Personal folder and then select Paste.

• Open a workflow in the Templates folder by double-clicking 

and then use the Save icon to save it in the Personal folder.

• Open a workflow in the Templates folder by right-clicking 

and then selecting Open As New. Use the Save icon to 

save it in the Personal folder.
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Using Biologics Explorer: General Overview

RECOMMENDATIONS FOR CORRECT USE OF THE RESOURCES

• Follow best practices to make sure that Biologics Explorer 

has sufficient memory and computing power:

‒ Only run one workflow at a time: Some activity nodes are very 

resource intensive. Co-processing might use up all available 

resources.

‒ To conserve memory, activate the Trash icon whenever possible in 

optimized workflows.

‒ After reviewing data and saving results, reset or dispose workflows 

before starting a new analysis.

‒ Use Save Snapshot activity nodes to enable completed results to be 

saved or reviewed in the Pepmap_ReviewSnapshots workflow. 

• The processing computer should have at least 250 GB of 

free disk space and 6 GB of In-Memory Cache.

‒ Files being processed for peptide mapping workflows              

should not add up to more than 4 GB.



10 © 2022 DH Tech. Dev. Pte. Ltd.

• For information about individual activity nodes 

and their settings, click the ? icon to view the 

relevant Help pages.

Using Biologics Explorer: General Overview

ACCESS THE ONLINE HELP
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3. GENERAL GUIDELINES FOR PEPTIDE MAPPING 

WORKFLOWS

Part A
Software and Workflows
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General Peptide Mapping Workflow Guidelines

WORKFLOW TYPES

Pepmap_Simple

Pepmap_ReviewSnapshots

Pepmap_Comparative
Pepmap_Extended

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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COMMON ACTIVITY NODES IN THE PEPTIDE MAPPING WORKFLOWS 

A. Load Raw Data

B. RT Range Restriction

C. Chromatogram View

D. Data Preparation [Container]

i. Chromatogram Chemical Noise Subtraction

ii. Chromatogram RT Alignment

iii. Chromatogram Peak Detection

iv. Chromatogram Isotope Clustering

v. Singleton Filter

E. Peptide Mapping

F. Review Results

G. Reporting and Exporting

General Peptide Mapping Workflow Guidelines

vi. Charge and Adduct Grouping 

vii. MS/MS Consolidation 

viii. MS/MS Peak Detection

ix. MS/MS Deisotoping

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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General tab.

• Type into the Name field to define the analysis.

• Upload raw data files   :

‒ Select only wiff or wiff2 container files.

• When analyzing data from the ZenoTOF 7600 system, 

use only wiff2 files and not wiff files.

‒ Do not select the auxiliary files with the same name.

Load Raw Data: Add Analysis Name and Data Files

‒ To view files within a wiff1 or wiff2 container, double-click the wiff or wiff2 container to 

open it.

• Choose the files to upload from the list of embedded files.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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• If individual sample files within a wiff or wiff2 container have the same name, then do not 

use the Auto Detect option.

• To make sure that unique sample names are present in the Experiment Table, and that 

Review Results displays the correct quantitative information for each sample:

1. From the Format dropdown list select either Sciex Wiff or Sciex WiffTwo.

• Only use wiff2 for data acquired using the ZenoTOF 7600 system. 

2. Select the Use File Name as Sample Name check box.

Load Raw Data: Format

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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• Run the Load Raw Data activity node and then 

open (double-click) it when data loading is 

complete. 

• Identify the retention time (RT) range where 

there is meaningful data present.

‒ Exclude stray signals caused by valve switching 

or column wash.

‒ Focus on the separation range.

Note: If the fields are blank, then the full RT range is 

used.

Restrict the RT Range

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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• Change this setting only if the default noise removal is 

too harsh, which can be identified by:

• Loss of low intensity isotope peaks from singly (+1) or doubly 

(+2) charged clusters, or from low intensity clusters of interest.

• Excessive cutoff of the tails of very wide (extended RT) peaks.

• If clusters of interest are affected, or if the unwanted peak 

modifications that are described above appear too 

frequently, then set the Quantile to a lower value, such 

as 50%.

Data Preparation: Chemical Noise Subtraction - Quantile

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS



18 © 2022 DH Tech. Dev. Pte. Ltd.

Data Preparation: Chemical Noise Subtraction - RT Window 

To determine the number of scans:

1. Locate a feature that extends over a 

longer RT than other features in the 

ion map.

2. Take a vertical slice to generate an 

Extracted Ion Chromatogram.

3. Right-click in the Extracted Ion 

Chromatogram window and select 

Profiles.

4. Use the Advanced Filter Tool        

to select the RT range for the peak.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Take a vertical slice

• If the largest peak in the dataset contains less than 50 scans, 

then decrease the RT Window (to 101 or 151 scans, for 

example).

‒ As a rule of thumb, the RT Window should be at least double the number 

of scans across the largest peak in the dataset.
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• If the noise level is significantly different from the 

Threshold value pre-set in the Chromatogram Chemical 

Noise Subtraction activity, then change this setting.

• To measure the noise level and determine an appropriate 

Threshold intensity value:

1. Expand the mass spectrum intensity axis by dragging it until the 

noise level is readable, or change the axis from linear to the log 

scale using the icon in the tool bar.

2. Use the crosshair tool    to measure the intensity of the noise level.

Data Preparation: Chemical Noise Subtraction - Threshold

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Noise level
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Data Preparation: Chromatogram Peak Detection

• The peak splitting of closely eluting components in the RT 

direction can be modified as required.

‒ To decrease splitting: Increase the Gap/Peak Ratio.

‒ To increase split sensitivity: Decrease or remove Smoothing.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Data Preparation: MS/MS Consolidation

• This activity node merges MS/MS data across equivalent 

peaks and clusters.

‒ Consolidation can improve MS/MS spectra, resulting in more 

identifications.

‒ Consolidation can reduce false positives if MS/MS spectra are 

too ambiguous.

• There is an option to merge MS/MS Across Chromatograms.

‒ This improves confidence in identifications across technical replicates.

‒ Do not use this option when assessing individual sample        

sequence coverage.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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General tab:

• Instrument: Select according to specific 

experimental set-up.

‒ To review or modify: Navigate to File > Tools > 

Instrument Editor.

Peptide Mapping: Configure Settings (1)

• m/z Tolerance: 

‒ The default value (0.95 Da) is not a reflection of MS mass accuracy. It increases 

the possible options for identification as a compromise for the potential impact of 

MS/MS pre-processing on the m/z. 

• Reduce the m/z Tolerance to 20 ppm when data generated using the ZenoTOF 7600 system 

is being analysed. The m/z Tolerance can also be reduced to 20 ppm for analysis of data 

generated using other MS systems.

• Reducing the m/z Tolerance limits the number of false positives or ambiguous annotations 

that are generated.

‒ The default value can be increased if required, for example, if the                        

data has wide error distributions.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Peptide Mapping: Configure Settings (2)

Modifications tab:

• View the list of possible Fixed or Variable modifications 

by opening the Select Entries dialog using the + on the 

left.

‒ Commonly used modifications can be added as favorites 

by selecting the star icon.

‒ To analyze over- or under-alkylation, set the alkylating 

reagent to Variable for cysteine and other target amino 

acids.

Sequence tab:

• Sequence(s): Paste as text or upload as a FASTA file.

‒ Enzyme specificity, maximum number of missed cleavages, and minimum peptide 

length can be adjusted as required.

• Enzymes: To view the list of system-configured and user-defined enzymes, 

open the Select Entries dialog using the + on the left.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Peptide Mapping: Configure Settings (3)

• Max. Number of Glycans per Peptide: There is a threshold number of Estimated 

Glycopeptide Candidates allowed for the search to proceed (refer to next page for details). 

Note: Disabling Glycan Fragments for 

glycopeptides in the Edit Instrument 

settings reduces the time required for 

complex glycan searches. 

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Glycosylation tab:

• Library: Select a system-configured or a user-defined library.

‒ To review or modify a glycan library: Navigate to File > Tools > 

Library Browser > Resources.

It is recommended 

to have Glycan 

Fragments enabled 

for data acquired in 

CID mode.

‒ Allowed Sites: Only N-linked: There is typically fewer potential consensus sequences per 

peptide, so searches for N-glycosylation are generally more tolerant of search criteria:

• Up to 4 N-glycans per peptide is the maximum allowed value.

• The number of missed cleavages and variable modifications impacts the search time.

‒ Allowed Sites: Only O-linked: Every serine and threonine (S and T) residue is a potential 

site for O-glycosylation. 

• Long peptides containing many potential glycosylation sites dramatically impact the number of 

Estimated Glycopeptide Candidates, and the subsequent processing time. 

• Using enzymes that result in shorter peptides, for example using Trypsin/P in the settings so that 

cleavage is not restricted at RP/KP, can help to reduce the search time and                                      

limit the total number of candidates.
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Peptide Mapping: Configure Settings (4)

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Glycosylation tab:

• A combination of factors is used to calculate the number of Estimated 

Glycopeptide Candidates to determine if the search will proceed:

‒ The number of glycans in the glycan library (including Substituents).

• Use the smallest library size that contains the relevant glycans of interest,

• Selecting Filter for Core Structures can help to limit the candidates.

‒ The maximum allowed number of glycans per peptide.

• Do not exceed what is expected for the molecule. Lower values allow larger 

libraries to be used, and vice versa.

‒ The theoretical sites of glycosylation on a peptide.

• The number of missed cleavages and the enzyme specificity contribute to this.

• Other search parameters contribute to the overall search time. 

‒ To reduce the time to completion:

• Disable Glycan fragments in the Edit Instrument settings.

• Minimize the variable modifications and their number per peptide.

• Maximize the minimum peptide length.

• Reduce the number of glycans per peptide.

• Reduce the size of the glycan library.

Example of permitted search combinations for 

O-glycans in Etanercept digested with trypsin:

Enzyme: Trypsin

Missed cleavages: 1

Enzyme: Trypsin/P

Missed cleavages: 0
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Peptide Mapping: Configure Settings (5)

Disulfide tab:

• For non-reduced samples: Set Connectivity to Fixed. Specify 

the expected disulfide bridges using the correct syntax, for 

example; HC:22-HC:97.

‒ The chain names must match those specified in the Sequence

tab.

• For reduced samples: Set Connectivity to None.

Peptide Chromatograms tab:

• These settings control the layout of peptide chromatograms 

when viewing the results of this activity, and do not need to be 

changed.

Report tab:

• We recommend setting Volume as the Observable for data 

acquired using a QTOF system.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Review Results: Configure Settings

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

Sequence tab:

• Sequence(s): Paste as text or upload as a FASTA file.

‒ Use the same FASTA protein sequences in the Peptide 

Mapping activity node and the Review Results activity node. 
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Review Results: Review Peptide Mapping Results

• Open the Review Results activity node to review the combined results of any 

preceding Peptide Mapping activity nodes.

1. Activate the Review mode and 

accept one annotation for all 

relevant peaks.

2. Reject all other redundant 

annotations.

3. Click Save to apply the changes.

The activity node runs again to 

automatically recalculate peptide 

quantities.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Review Results: Isomer Differentiation

• During MS/MS analysis using EAD, diagnostic internal 

fragment ions are produced that enable differentiation 

between isomeric amino acid residues. 

‒ To confirm the presence of leucine (Leu) or isoleucine (Ile):

• Ions are annotated in the MS/MS spectra as wn or wnb.

‒ Leucine: A wn ion at a 43 Da mass shift from the corresponding z+1 ion.

‒ Isoleucine: A wn ion at a 29 Da mass shift from the corresponding z+1 ion.

‒ To confirm the presence of aspartic acid (Asp) or isoaspartic

acid (IsoAsp):

• Ions are annotated in the MS/MS spectra as cn+57 or zm+1-57.

‒ cn+57 or zm-+157 ions annotated in the MSMS spectra signify the 

presence of isoaspartic acid. 

‒ Aspartic acid does not generate these diagnostic internal fragment ions 

because there is no methylene group in the peptide backbone.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS

∆-29 Da

∆-43 Da

Deamidated (IsoAsp)
[N289]

Asp -> IsoAsp
[D283]

Note: Use an m/z Tolerance of <20 ppm in the 

Peptide Mapping activity node for optimal results.
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Review Results: Isomer Differentiation (Cyclization and Deamidations)

• To simplify data review, it is 

possible to filter for relevant 

modifications. For example:

‒ Asp → IsoAsp

‒ Deamidated

‒ Deamidated (IsoAsp)

• The diagnostic internal fragment 

ions present in the MS/MS 

spectra can then be used to 

validate identifications, and 

results Accepted or Rejected as 

required.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Review Results: Create Custom Layouts

• Each pane can be disconnected and 

docked at a new location.

• The location where the disconnected pane 

will be docked is highlighted by a blue box.

• To move the Ion Map into the Peptides

tab:

1. Select the Data tab and click the icon to 

disconnect the Data tab window.

2. The ion map, or any pane from the Data tab 

window, can then be undocked and dragged to 

a new location on the Peptides tab.

• Favorite layouts can be saved and 

accessed with the Layout icon.
Click to disconnect the Data tab window.

Click to save or load saved Layouts.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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• Select the folders in which results will be stored.

• Two types of results are stored:

• Snapshots:

‒ Snapshots are intermediate results saved permanently as sbf files.

• Snapshots saved from pre-processed data store the intermediate 

results generated after Chromatogram Chemical Noise Subtraction 

and Chromatogram RT Alignment. 

• Snapshots saved after Review Results store all of the intermediate 

information, including annotations of features.

• PDF Reports, which embed:

‒ A PDF document.

‒ An Excel file with spectral information from deconvolution.

‒ An Executed workflow (xml file), that includes the settings used to 

generate results.

• To open the xml file, drag and drop it into the Biologics Explorer 

workflow home page.

Reporting: Define Destination for Snapshots and Reports

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Reporting: Save Intermediate Results

• Store intermediate results after different activity nodes 

through-out the workflows.

‒ Save Snapshot activity nodes create a file (sbf) that contains the 

required properties of the processed data.

• To review stored data, open sbf files in the Load Snapshots

activity nodes in the Pepmap_ReviewSnapshots workflows.

‒ Load snapshots from Save Annotations Snapshot to review 

results from the same dataset.

‒ Load snapshots from Save Pre-processed Snapshot to analyze

results from different batches.

• Saved sbf files can also be loaded into the Load Raw Data 

activity node in any workflow.

‒ Load snapshots from Save Annotations Snapshot and bypass all 

activity nodes except for those required for peptide mapping to 

add more searches to an analysis.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Reporting: Export PDF Report

• General tab: Define the destination 

of the exported report.

• Template tab: Customize the 

contents of the report.

• Excel tab: Customize the tables that 

will be exported with the report.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS
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Reporting: Export to SCIEX OS

• General tab:

‒ Define the destination of the reviewed results. 

‒ Define the requirements of the export, for example, the required 

number of clusters for each group.

• The Export to SCIEX OS activity node should not be used in 

combination with the Wildcard Mapping activity node.

‒ The Wildcard Mapping activity node can be bypassed in relevant 

workflows.

Note: The modification position exported with the Export to SCIEX OS activity node is 
relative to the peptide, not the protein. For example, DTL[M]ISR would be M4 not M255.

GENERAL GUIDELINES FOR PEPTIDE MAPPING WORKFLOWS



36 © 2022 DH Tech. Dev. Pte. Ltd.

GUIDELINES FOR SPECIFIC PEPTIDE MAPPING 

WORKFLOWS

Part B
Workflows and Applications
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WORKFLOW SPECIFIC GUIDELINES

Simple Peptide Mapping
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Simple Peptide Mapping Workflow: Design

Pepmap_Simple

GENERAL GUIDELINES FOR SIMPLE PEPTIDE MAPPING WORKFLOWS
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• Use this workflow when completing routine 

analyses with non-complex biotherapeutic 

molecules.

• The combination of search parameters in the 

Peptide Mapping activity node identifies 

commonly expected peptides and 

modifications, including glycosylation.

Simple Peptide Mapping Workflow: Overview

GENERAL GUIDELINES FOR SIMPLE PEPTIDE MAPPING WORKFLOWS
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WORKFLOW SPECIFIC GUIDELINES

Extended Peptide Mapping
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Extended Peptide Mapping Workflow: Design

Pepmap_Extended

GENERAL GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS
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1. PepMap

‒ Identifies the most expected peptides and modifications.

2. PepMap

‒ Digs deeper into the sample.

‒ Ignore Annotated Features: Makes sure that only unannotated 

features from the previous search are considered.

3. Wildcard Mapping

‒ Searches for unexpected modifications, which can be subsequently 

added to 1.PepMap or 2.PepMap activity nodes.

Extended Peptide Mapping

Note: For biotherapeutics with expected N- and O-glycosylation, false positives 

are reduced when 1.PepMap is used to identify expected N-glycans, and 

2.PepMap focuses on the typically less well characterised O-glycans.

GENERAL GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

• For a more comprehensive peptide mapping analysis, results from up to 

three consecutive activity nodes can be combined to extend the search 

space while minimizing false positives:
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• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required.

Example 1: Disulfide bond (DSB) analysis for non-reduced samples.

• Key settings specific to this type of analysis:

Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

1. PepMap

• Sequence tab: Enzyme - Fully specific.

• Disulfide tab: Fixed Connectivity.

‒ Define the expected disulfide bridges using the correct 

syntax (HC:22-HC:96).

2. PepMap

• Sequence tab: Enzyme - Fully specific. 

• Disulfide tab: Scrambled Connectivity.

3. Wildcard Mapping

• On All Peptide Candidates for more annotations 

relating to unknown modifications.
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• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required:

Example 2: Post translational modification (PTM) analysis.

• Key settings specific to this type of analysis:

Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

1. PepMap

• Sequence tab: Enzyme - Fully specific.

• Modifications tab: Abundant and expected modifications.

2. PepMap

• Sequence tab: Enzyme - Semi-Specific. 

• Modifications tab: Shorter list of expected modifications. 

Or:

• Sequence tab: Enzyme - Fully specific.

• Modifications tab: Alternative set of less common 

modifications that might be expected at low abundance. 

3. Wildcard Mapping

• On All Peptide Candidates for annotations                 

relating to unknown modifications.
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• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required:

Example 3: Sequence Variant Analysis (SVA).

• Key settings specific to this type of analysis:

Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR EXTENDED PEPTIDE MAPPING WORKFLOWS

1. PepMap

• Sequence tab: Enzyme - Fully specific. No missed cleavages.

• Modifications tab: Fixed alkylation (cys) with variable modifications limited 

to the predominant form (for example, pyro-glutamation). Sequence 

Variants - All Substituents (Restrict Matches cleared). 

2. PepMap

• General tab: Low Mass Tolerance. Clear Ignore Annotated Features.

• Sequence tab: Enzyme - Semi-Specific. 1-2 missed cleavages.

• Modifications tab: Variable alkylation on commonly modified amino acids to 

detect overalkylation, with all other expected variable modifications.

3. Wildcard Mapping

• On Only Annotated Peptides. 
• Use Review Results to compare additional annotations on the same                         

features to rule out false positives.

or



46 © 2022 DH Tech. Dev. Pte. Ltd.

WORKFLOW SPECIFIC GUIDELINES

Comparative Peptide Mapping
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Comparative Peptide Mapping Workflow: Design

Pepmap_Comparative

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS



48 © 2022 DH Tech. Dev. Pte. Ltd.

• The activity nodes connected with green lines contain 

statistical tools. 

• These statistics activity nodes can be used to compare 

two datasets, and report peptides that are either:

‒ Absent in one sample set but present in the other.

‒ Have a specified fold-change difference between sample 

sets.

Comparative Peptide Mapping

These statistical activity nodes identify the features 

that differ significantly between the two sample 

groups being compared in the workflow.

• Example use cases:

‒ To compare reduced and non-reduced samples.

‒ To compare stressed and unstressed samples.

‒ To compare a reference sample with samples from a 

new batch.

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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• On the General tab, click the table icon to open the Metadata Editor.

• Specify the Group names for the files to be compared.

• Optionally, add a Color column and define colors for each group.

Load Raw Data and Define Groups

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required:

Example 1: DSB analysis for comparing reduced and non-reduced samples.

• Key settings specific to this type of analysis:

Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

1. PepMap

• Sequence tab: Fully specific.

• Disulfide tab: Fixed Connectivity.

‒ Define the expected disulfide bridges using the correct 

syntax (HC:22-HC:96).

• Modifications tab: Variable alkylation (cys).

2. PepMap

• Sequence tab: Fully specific. 

• Disulfide tab: Scrambled Connectivity.

3. Wildcard Mapping

• On All Peptide Candidates for more                 

annotations relating to unknown                      

modifications.
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• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required:

Example 2: Comparative analysis for stress testing and lot-to-lot variability.

• Key settings specific to this to this type of analysis:

Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

1. PepMap

• Sequence tab: Fully specific.

• Modifications tab: Abundant and expected modifications.

2. PepMap

• Sequence tab: Unspecific enzyme. 

• Modifications tab: Shorter list of expected modifications. 

Or:

• Sequence tab: Fully specific.

• Modifications tab: Alternative set of less common 

modifications that might be expected at low abundance. 

3. Wildcard Mapping

• On All Peptide Candidates for more                     

annotations.
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Step-Wise Peptide Mapping: Application Examples

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS

• Three consecutive peptide mapping steps can be combined, depending on 

the type of analysis required:

Example 3: SVA for comparing wild type (WT) and mutant samples.

• Key settings specific to this type of analysis:
1. PepMap

• Sequence tab: Enzyme - Fully specific. No missed cleavages.

• Modifications tab: Fixed alkylation (cys) with variable modifications limited 

to the predominant form (for example, pyro-glutamation). Sequence 

Variants - All Substituents (Restrict Matches cleared). 

2. PepMap

• General tab: Low Mass Tolerance. Clear Ignore Annotated Features.

• Sequence tab: Enzyme - Semi-Specific. 1-2 missed cleavages.

• Modifications tab: Variable alkylation on commonly modified amino acids to 

detect overalkylation, with all other expected variable modifications.

3. Wildcard Mapping

• On Only Annotated Peptides. 

• Use Review Results to compare additional annotations on the                              

same feature to rule out false positives.

or
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• Valid Feature Filter: Removes any features below a set threshold,

and those present in less than a set % or number of experiments.

‒ This filtering removes insignificant differences or any signal due to noise or 

artifacts. If expected peptides are not present, optimize this setting.

• Data Setup: Prepares data in a matrix form that can be used as 

input for filtering and statistics tasks.

‒ If Groups were not set in Load Raw Data, they can be defined here. 

Differential Analysis Activity Node Settings

• Group Change: Calculates relative and 

fold-change differences between 

experiment groups.

‒ If multiple experiment groups are present, 

then the reported change is the maximum 

difference between any two groups.

• Feature Condensing: Groups features based on their annotations.

‒ Computes a single intensity value for each of the created groups.

• Normalization: Provides a comparable basis for further statistical 

analysis.

‒ Percent Abundance: Values are summed across all members of each group 

for each experiment. Each value is divided by the sum from the 

corresponding group and multiplied by 100.

Note: Settings are linked to previous activity nodes: Run Data Setup before editing Feature Condensing.

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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Differential Analysis: Data Preparation

• Feature Condensing: Combines features based 

on existing annotations and calculates a single 

intensity value (sum, average, median, or max) for 

each group. For example, the same peptide, from 

the same protein, with the same modification will 

be summed using these settings. 

‒ Run the Data Setup activity node before editing 

the Feature Condensing settings. 

Protein Peptide Modification

Grouped by

100% 100%

Normalize by: Peptide

Group 1 Group 2 Group 3 Group 4

Lot-to-lot comparability

DSB analysis

• Define Groups in the Load Raw Data activity node 

by editing the Metadata table (preferred option). 

• If required, define Groups in the Data Setup activity 

node, using Group: Manually and assigning each 

sample to a group.

• Normalization: This will report Percent Abundance 

of condensed features relative to the selected type 

of annotation. For example, if Group by is set to 

Peptide, then the % abundance is calculated per 

peptide. If Group by is left blank, then the % 

abundance is calculated across the whole sample. 

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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New and Highly Changing Feature Detection

• The Absent/Present activity node can facilitate New Peak 

Detection (NPD).
‒ The sliders are applied in the input window that opens when the 

activity node is run.

‒ Moving the sliders filters the results. For example, for DSB 

analysis, the desired features are expected to be Absent in the 

reduced sample and Present in the non-reduced sample.

• For Highly Changing Features, the desired minimum fold 

change must be set in the activity node settings.

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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Synchronized Selections for Simplified Data Review

Synchronize selection 

Open all three windows and activate Synchronize selection in Review Results for dynamic linking.

GENERAL GUIDELINES FOR COMPARATIVE PEPTIDE MAPPING WORKFLOWS
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WORKFLOW SPECIFIC GUIDELINES

Review Stored Results
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Review Peptide Mapping Snapshots Workflow: Design

Pepmap_ReviewSnapshots

GENERAL GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS
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• When multiple samples are analyzed in 

other Peptide Mapping workflows, each 

sample generates its own sbf file.

• When loading saved Snapshots into the 

Pepmap_ReviewSnapshots workflow, 

select all individual sbf files within the 

parent folder.

‒ Data will not load if parent folder is selected.

Review Results from Same Batch

GENERAL GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS
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• Use this workflow to review previous results from samples 

that have been analyzed together previously and have 

peptide annotations.

Review Results from Same Batch

• The Review Results activity node 

opens a copy of the previous analysis, 

including any previously accepted and 

rejected peptides that have the relevant 

entry in the Flags column.

• A further review is then possible, and 

the reviewed snapshots can be saved, 

if required.

GENERAL GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS
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Review Results from Different Batches

• Data from different analyses can be pre-processed 

independently and then the Snapshots combined.

• Data requires feature detection including RT Alignment and 

common Peak Detection, followed by the Peptide Mapping 

activity nodes for feature annotation.

‒ If Pre-processed Snapshots are used to process data from the 

same batch, then bypass the RT Alignment activity node.

• Comparisons between different groups of samples are also 

possible.

‒ Groups defined in the original workflow are maintained.

‒ If not previously defined, groups can be defined within the Load 

Snapshots or the Data Setup activity nodes.

GENERAL GUIDELINES FOR REVIEW SNAPSHOTS WORKFLOWS
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For more information, visit the 
SCIEX website at sciex.com, or 
contact us in one of the following 
ways:

sciex.com/contact-us
sciex.com/request-support
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Trademarks / Licensing

The SCIEX clinical diagnostic portfolio is For In Vitro Diagnostic Use. Rx Only. 

Product(s) not available in all countries. For information on availability, please 

contact your local sales representative or refer to https://sciex.com/diagnostics.  

All other products are For Research Use Only. Not for use in Diagnostic 

Procedures. 

Trademarks and/or registered trademarks mentioned herein, including 

associated logos, are the property of AB Sciex Pte. Ltd. or their respective 

owners, in the United States and/or certain other countries (see 

sciex.com/trademarks). 
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